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 How do I get my Stata Output into a Table? 

 
1. Know your audience--What type of table do you need to produce? 

• For the prof you work for? 
• For a class paper, conference, or journal? 
• For a conference poster? 
 

2. Gather your materials: 

• Find a recently published article with a similar research design in the journal you will be submitting 
to. 

• If you don’t know, go with APA format.  
https://owl.english.purdue.edu/owl/resource/560/01/ 

• Open the necessary programs on your computer: 
o Stata 
o Excel  
o Word 

 
3. Set your margins in Excel 

 

 
  

https://owl.english.purdue.edu/owl/resource/560/01/
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4. Generate tables in Stata—using estimates commands 

 If you look at my Do-file, I have a log started at the top storing what is being displayed in 
the output window. 

o All output saved in a Stata log files, if saved as an “.sml” file, retains the same 
“copy” and “copy table” functions as if being copied from the Stata output 
window. 

 

 Also notice, I have a header depicting: 
o the file/program name 

o the specific task 

o the larger project this specific task is associated with 

o the author and the date the Do-file was started 

 

 I’m running logistic regression analyses comprised of five models. After I run each 
model, I type the command:  

  
. estimates store modelN 

  
o By doing this we are telling Stata to store the results in its working memory, so  

that we can later tell Stata what to display when we run another command
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 After running all my models, I can then command Stata to produce the models of my choice 
together in the form of a simple table, by typing: 

 
. estimates table model1 model2 model3 model4 model5 

 

When doing so we get this output… 
 
------------------------------------------------------------------------------- 

    Variable |   model1       model2       model3       model4       model5     

-------------+----------------------------------------------------------------- 

boomerang_cs | -.38394325   -.32289543   -.29467411   -.36142479   -.34357681   

 plnmvout_cs |              -.42568424    -.4941286   -.50524127   -.52201004   

   payany_cs |              -.29451219   -.33561217   -.21573598   -.19835859   

     age1923 |                            .02314174    .05050027     .0464386   

        male |                            .01879246   -.02130933   -.04100863   

             | 

     ethrace | 

   2. Black  |                             .3896079    .45061936    .45208932   

3. Hispanic  |                             .5645867    .60556757    .61579612   

   4. Other  |                           -.57156084   -.69895938   -.66721316   

             | 

 goodhlth_cs |                                         .69876912    .71110143   

  mhealth_cs |                                        -.18117434   -.17903428   

             | 

         edu | 

   1. <H.S.  |                                        -.04948128   -.03471297   

    2. H.S.  |                                        -.05778116   -.05438757   

  3. S.Col.  |                                        -.12287664    -.1248107   

             | 

    enrolled |                                         .06616018     .0571787   

     curwork |                                        -.00256022   -.01759482   

ln_indinc_~s |                                         .01462601    .01383715   

             | 

relstdater~s | 

  1. Single  |                                                      .06739666   

  2. Dating  |                                                      .14322095   

             | 

      dbiokd |                                                     -.10739817   

             | 

  parentcomp | 

1. Mom, o..  |                                                     -.05301778   

2. Dad, o..  |                                                     -.19255328   

             | 

  sibagecomp | 

1: Only ..)  |                                                      .03496901   

2: Only ..)  |                                                     -.04589592   

3: Both ..)  |                                                      .07596144   

             | 

       _cons |  5.7554709    6.1174281    6.0206667    5.6450508      5.58019   

------------------------------------------------------------------------------- 
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 For more information on the estimates command and its associated options, type: 
 

. help estimates  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Generally I will generate two different tables,  
1. One is a guide to help me identify the significant coefficients more quickly, I’ll save and print 

this 
2. The other has the standard errors associated with the coefficients, which I use for copying and 

pasting into Excel.  
 

*Stata cannot generate a table with both stars AND S.E.s. 
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 To get the table with the stars, I type: 
  

. estimates table model1 model2 model3 model4 model5, b(%10.2f) star 

(Note: highlighting added by author) 
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5. Get Stata table in Excel 

 Generate the table with relevant statistics and standard errors by typing 

. estimates table model1 model2 model3 model4 model5, b(%10.2f) stats(N 

r2) varlabel allbaselevels se 

1. In the Stata output window, select your table 

2. Right click, and a selection box will pop-up 

3. Choose “Copy table” 
 

 

 

 

  

#1 

#2 

#3 
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6. Paste table into Excel 

 Paste into Excel (I usually just use Ctrl+v) 

 

7. Format…in Excel first (before transferring to Word) 

 Make cells to fit the width of your text (for workability) 

 Change to landscape orientation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

 

 

 

 

 

Before After 

Note: I also add a column between each model 
which I don’t discuss until the next page. 
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 Get SEs beside your coefficients 

o Insert rows beside the ones with your coefficients 

o Copy the cells below the first coefficient in each model and past it in the row beside it 

(the one you just inserted/added). I changed them to green so it’s easier for you to see. I 

also added arrows in the first two columns so you could see, they were in fact 

transferred up. 
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o Now get rid of the onerous rows…this can be a bit dizzy making. Select/click on the 

individual rows of data while holding down on the Ctrl key…allows you to delete more 

than one at a time. 
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 Clean up your variable names/labels 

o If you decide to indent in Excel, be sure to use 

the indent button NOT the space bar. Add 7 pt 

rows between the models 

 Clean up your header 

o Add another column for your stars between the 

coefficient and the SE. 

o Add 10 pt columns between the models 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Before 

After 

Indent Button 
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Next… 
o Change the green text back to black. 
o Merge appropriate cells—do not MERGE cells above and below does something and 

can’t manipulate the cells once you place into Word. Only merge cells across columns 

(from the left and right). 

o Add underlines—again, you need to do this here, because it doesn’t always work 

correctly once you are in Word. 

o Add your legend (bottom of table not shown) 

o Add in your stars—making sure they are left-justified, and that the corresponding 

coefficients are right-justified. 

o Watch out for your decimals…be sure you haven’t lost them. You may have to select all 

of your data and format as a number. 

o Go through and adjust the width of your columns. 

o If you haven’t done so, add your table title. 

o Notice, everything is within the bounds of the page? I think we are ready to paste into 

Word! 

 
 
 
 
 
 
 
 
 
 
  

Variables SE SE SE SE SE

Boomeranged -0.38 * 0.16 -0.32 * 0.16 -0.29 0.16 -0.36 * 0.16 -0.34 * 0.16

Plans to move out -0.43 ** 0.15 -0.49 ** 0.15 -0.51 *** 0.15 -0.52 *** 0.15

Pays room and board -0.29 0.18 -0.34 0.19 -0.22 0.18 -0.20 0.19

Aged 19-23 0.02 0.18 0.05 0.17 0.05 0.18

Male 0.02 0.15 -0.02 0.15 -0.04 0.16

Race/Ethnicity (White, 

ref.)

Black 0.39 * 0.16 0.45 ** 0.16 0.45 * 0.18

Hispanic 0.56 ** 0.21 0.61 ** 0.21 0.62 ** 0.21

Other -0.57 0.43 -0.70 0.44 -0.67 0.44

Good physical health 0.70 ** 0.25 0.71 ** 0.26

Depressive symptomology -0.18 ** 0.07 -0.18 ** 0.07

Table 2. Logistic Regression Predicting Young Adult Satisfcation with Parental Coresidence Situation

Model 1 Model 2 Model 3 Model 4 Model 5

b b b b b
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8. Paste Table into Word 

1. Select your table and copy it 
2. Be sure your Word document is set to landscape orientation 

3. Right-click in Word, choose the first “Paste Option”  “Keep Source Formatting”. Notice 
everything isn’t lined up quite right? I’m going to show you how to use “Autofit” on the next 
page. 

 

 
    
 
  

Not everything is lined up??? 

#3 
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4. Using AutoFit: Click on your table and a small box with two perpendicularly crossed arrows will 
appear in the upper left corner  Right-click on it and the following pop-up box will appear…  
click on “AutoFit,” and choose the “AutoFit to Window option.” 

 

    
  

Small box with two perpendicularly crossed arrows 
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 Next, you will want to adjust your cell margins 
1. Click on your table so the “Table Tools” will show up in your ribbon and choose the 

“Layout” tab 

2. Click on “Cell Margins.” 
3. The following window will pop up… 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Change the left and right margins to no more than 0.02”. You may want to adjust 

the left margin to 0.01” or 0.0”, you’ll just have to do what is right for your 

particular table. Note: this will change the cell margins of ALL the cells in this 

particular table, but not previous or subsequent tables in your document. 

4. You may still need to do some tweaking to get everything lined up. To make this a 
little easier, while you are in the “Layout” tab click on the “View Gridlines option on 
the far left (see above). 

5. If you make the width of your columns smaller, you will allow for more room for 
your variable names and categories. Be sure to work from right to left when 
changing columns widths. 

#1 
#2 

#4 
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 Indent you value labels on your multi-category variables 
1. Highlight the cells you are going to indent. 

2. In the ribbon click the Home tab. 

3. Go to the Paragraph group and right-click the arrow in the bottom right-hand 

corner—the Paragraph window will open. 

4. Under indentation, adjust the Left indentation to 0.2”. 

5. Click “OK.” 
 

 

#1 

#1 

#1 

#2 

#3 

#4 

#5 
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 Notice below, that some of the variable names/categories that used to take up more than 
one line before formatting now only take up one? You will want to go in and change their 
row heights to 0.20” or 0.21”. 
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1. Highlight the row you are going to adjust the line height on. 
2. In “Table Tools,” click on the “Layout” tab.  
3. In the “Cell Size” group click on the arrow in the bottom right hand corner of the group. 
4. A “Table Properties” pop-up box will appear. In the “Row” tab specify a row height of 0.2” or 

0.21” and choose “Row height is: Exactly” from the drop-down menu.  
5. Click “OK.”  

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

#1 

#2 

#3 

#4 

#5 
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You should be left with a beautifully formatted Word table! 

 

 


